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Motion Sensor
Range 1: Distance 0.17 - 10 m
Resolution: 0.001 m (1 mm)

Range 2: Distance 17 - 1000 cm
Resolution: 0.1 cm

Range 3: Distance 7 - 400 inches
Resolution: 0.1 inch

Range 4: Time 1000 - 60,000 µs
Resolution: 1 µsProduct No 3705

(Self-powered type)

Product No 3270
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Introduction 
The Smart Q Motion Sensor is a sonar device that emits ultrasonic pulses, which 
reflect off an object. It measures the time it takes a high frequency sound pulse to 
travel from the Sensor to an object and back. This time data is used, together with 
the speed of sound, to determine the distance of an object from the Sensor. 

There are two types of Smart Q Motion Sensor: 
1. The original type (Product No. 3270), which takes the power it requires from the  
 EASYSENSE unit. This makes it unsuitable for use with the EASYSENSE Flash  
 Logger, Link, and V1.2 or less of the Q3 and Q5 loggers. 

2. The self-powered type (Product No. 3705), which has an integral battery pack  
 and is supplied with a 12 V mains power supply.  This type can be used with any  
 EASYSENSE unit (including the EASYSENSE Flash Logger, Link, and V1.2 or  
 less of the Q3 and Q5 loggers). 

Both types of Motion Sensor are supplied with a steel rod (size 80 mm long x 10 
mm diameter with a M6 thread). The rod can be screwed into the mounting threads, 
which are found at the base and on the sides of the Motion Sensor. The rod can be 
used for clamping into a suitable holding device e.g. a retort stand.

The Smart Q Motion Sensor is equipped with a micro controller that greatly 
improves the accuracy, precision and consistency. It is supplied calibrated and the 
stored calibration is automatically loaded into EASYSENSE when the Motion 
Sensor is connected. 
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Connecting 
• Push one end of the sensor cable 
 (supplied with the EASYSENSE 
 unit) into the shape socket on the 
 side of the Motion Sensor with the 
 locating arrow on the cable facing 
 forwards.
• Connect the other end of the cable 
 to the input socket on the 
 EASYSENSE unit. 
• The EASYSENSE unit will detect 
 that the Motion Sensor is 
 connected and display values 
 using the currently selected range. 
 If the range is not suitable for your 
 investigation, set to the correct 
 range (see page 4).  
• The red signal LED on the Motion Sensor will only light when the EASYSENSE  
 unit is powered and a signal has been reflected from the object. It will emit a   
 clicking sound each time a pulse is sent.

Note: The red signal LED on the Motion Sensor is not a power on indicator; it is used to indicate that a   
reflected signal has been received from an object.

The Motion Sensor will start to pulse at approximately 50 pulses per second (every 
20 ms). If the time for a pulse to reflect off an object is longer than 20 ms (when the 
object is over 2 metres away), the pulses will slow. 

If your EASYSENSE unit goes into ‘sleep mode’ (nothing shown on LCD screen), 
the red LED on the Motion sensor will turn off and the unit will stop sending a pulse 
until the unit ‘wakes up’ to take a sample. 

EASYSENSE Flash Logger users: Power is only supplied to the inputs when data 
is being logged (e.g. when the Start icon has been selected). The Motion Sensor 
will not emit a clicking sound and the red signal LED will not light until a sample is 
taken.

Mounting
thread

Red 
signal 
received 
LED

Mounting
thread

Insert the sensor 
cable with the 
locating arrow 
facing forwards
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Power requirements
Motion Sensor (Product No. 3270)
This type of Motion Sensor takes the power it requires from the EASYSENSE unit. 
If logging continuously for long periods connect the EASYSENSE unit to a mains 
power supply. 

Motion Sensor (Product No. 3705) 
This Motion Sensor takes most of its power from its own batteries or from an 
attached mains power supply. It will not function correctly unless either the internal 
batteries are charged or it is connected to a power supply.

Note: The red signal LED on the front of the Motion Sensor is not used to indicate that the Motion Sensor is 
receiving power or that it is fully charged. It is used to indicate that a reflected signal is being received from 
an object. 

The mains power supply included with this Motion Sensor can perform two tasks:
 1. It can be used to re-charge the Motion Sensors internal batteries in 
  preparation for use away from mains power.
 2. It can be used to operate directly with the Motion Sensor connected to an   
  EASYSENSE unit.

The specifications for the power supply are 12V DC (optional unregulated) and able 
to source at least 500 mA, with a positive centre and negative outer pin.

When the self-powered Motion Sensor is connected to the mains power supply the 
batteries will automatically be re-charged unless the Motion Sensor is taking 
samples. When taking samples, the current from the power supply is diverted to 
provide power for sampling rather than charging the batteries. 

If the batteries are fully discharged attach the power supply and leave for a 
minimum of 10 minutes (without taking samples). Continue recording data with the 
power supply attached. If the batteries are fully discharged, it can take up to 7 hours 
to achieve full charge. 

Although the main power consumption of the Motion Sensor is via its own batteries, 
it will also utilise some power from the EASYSENSE unit (or the Pocket PC if used 
with the Flash Logger).

Side view of the 
self-powered 
Motion Sensor 
(Product No 3705)

Mounting thread

Power socket
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To set the range
• Connect the Motion Sensor to the EASYSENSE unit.
• Start the EASYSENSE program and select one of the 
 logging modes from the Home page e.g. EasyLog. 
 Select Sensor Config from the Settings menu. 
• Select the Motion Sensor from the list (it will be listed 
 using its current range) and click on the Change 
 Range button.
• The current range will be highlighted. Select the 
 required range and click on OK.
• Close Sensor Config. Click on New       and then 
 Finish for the change in range to be detected by the 
 logging mode.

The range setting will be retained until changed by the user. 

With some EASYSENSE units it is possible to set the range from the unit. Please 
refer to the EASYSENSE unit’s user manual.

Practical information
Fastest Speed - The maximum sample rate of the Motion Sensor is 50 Hz (20 ms). 

If an interval between samples of less than 20 milliseconds is selected, then either 
the set up will be rejected or the values obtained will default to zero. 

Note: The fastest speed that Version 1.0 - 1.3 Advanced users can log at is 40 Hz (25 ms). 

The data from the Motion Sensor is not suitable for use with the Timing function or 
the Time & Motion mode in the EASYSENSE software or data loggers. These 
functions will only use data from switch-type digital sensors. 

The Motion Sensor emits pulses of ultrasonic sound waves from the gold foil of the 
transducer. These waves will fill a cone that diverges at about 12º. The Motion 
Sensor then ‘listens’ for the echo of the ultrasonic waves returning. 

When stood upright on a flat surface the Motion Sensor will lean back at a 6º angle. 
This tilt allows the waves to run parallel with the horizontal surface. 

12 DegreesDistance measured
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The EASYSENSE unit measures how long it takes for the ultrasonic waves to make 
the trip from the Motion Sensor to the object and back. Using this time and speed in 
air, the distance to the nearest object is determined. Any object that reflects sound 
can be used as a target.

Note: The Motion Sensor will report the distance to the closest object that produces a sufficiently strong 
echo; this can be any object (such as chairs or tables) that are found in the cone of the ultrasound.

The Motion Sensor has been calibrated for 
measurements of distance to be made from the 
centre of the perforated cover of the transducer. 

The minimum distance between the object and 
the Motion Sensor should be 0.17 m (17 cm, 
7 inches).  The circuit inside the Sensor needs 
to switch off after a pulse has been sent to allow 
the transducer to stop oscillating before it tries to 
detect the reflected signal. 

The further the object is from the Motion Sensor, the wider the detection cone 
becomes. The best response is within 5˚ either side of the central line of the 
transducer. At long distances, stray objects become more of a problem. The 
sensitivity of the echo detection circuitry automatically increases in steps as time 
elapses before the echo returns. This is to allow for echoes being weaker from 
distant objects. This increase in step can produce a slight change in distance 
measurement that maybe become noticeable if the distance graph is differentiated. 

Before starting an investigation, use Meter or Test mode to determine if an object is 
providing a good reflection. Flat objects can be masked if they are not perpendicular 
to the waves. 

When the Motion Sensor is held in a clamp, experiment to find the best angle of tilt 
and therefore the best echo.

The Motion Sensor will continue to send pulses until the EASYSENSE unit stops 
asking for a reading. This may result in the clicking noise continuing after logging 
has stopped.

If you intend to collect remote data with the original unpowered Motion Sensor 
(Product No. 3270), check the batteries in the EASYSENSE unit are fully charged 
before you start. 

The self-powered type (Product No. 3705) will take most of its power from its 
batteries or power supply. If the batteries in the Motion Sensor are fully discharged it 
will not function. Attach the power supply and leave for a minimum of 10 minutes 

Transducer

Red signal 
LED
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(without taking samples). Continue recording data with the power supply attached. 
If the batteries are fully discharged, it can take up to 7 hours to achieve full charge.

Automatic correction for variation in air temperature has been incorporated into 
the Distance ranges. The Motion Sensor will use its internal temperature sensor 
to apply a correction factor to the value for speed of sound used in calculating the 
distance (344 ms-1 at 21ºC). Without compensation, values for large distances 
between hot and cold days could have an error of up to 0.5 m. The Time range is 
not temperature compensated. 

There is no compensation made for relative humidity or air pressure.

Although the moulding of the Motion Sensor has been designed to help protect 
the transducer, extra protection will be required if an object is being dropped from 
above. A protective wire mesh such as an office in-tray could be used. Test to 
ensure the wire does not interfere with the echo; the cone of the echo is at its 
narrowest close to the transducer. 

If data appears inaccurate
• Check the object is at least 0.17 m (17 cm, 7 inches) from the Motion Sensor. 
• Check for stationary objects e.g. tables, chairs, walls and floors that could be
 positioned in the cone of the ultrasound. They maybe detected instead of the   
 object, especially if it is at a long distance. 

• Other sound sources could cause a problem if they produce ultrasonic waves
 in the same frequency range (around 50 kHz) e.g. air track blowers, air exiting  
 holes on an air track. 
• Check that the reflecting surface reflects squarely. Try to increase the strength  
 of the reflection from the target by increasing the target area. 

The cone of ultrasound is 
detecting the work surface 
before reaching the object, 
so data will be inaccurate

Motion SensorMotion Sensor

The ultrasound is 
detecting the object
so data will be correct
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• When studying a person’s movement, the target may not supply a strong
 enough reflection e.g. by wearing non-acoustically reflective clothing. Get the   
 target to hold a large flat object in front of them as a reflector. 
• The surface reflecting the signal needs to be ‘silk finished’. If a surface is shiny  
 or reflective it can reflect signals. If the room has many sound reflecting 
 surfaces, ultrasound can bounce around the room. If this happens try covering  
 them with a cloth to reduce the reflections. 
• Sound absorbing surfaces such as acoustic ceiling tiles will produce errors, as  
 ultrasound will be absorbed.
• Balls made from foams or balls smaller than 5 cm diameter may not be 
 detected. The best size is 15 cm diameter or more. Using a light ball e.g. an   
 inflatable beach ball, to measure gravity is not advised since the air resistance  
 (compared to gravitational force) will be too large. 

If values default to zero
If an intersample time of less than 20 milliseconds is selected the values will 
default to zero. 

If values default to maximum 
• When the red LED on the self-powered Motion Sensor is flashing erratically 
 or is off, then it is possible that the batteries in the Motion Sensor are 
 discharged. Attach the power supply and leave for a minimum of 10 minutes
 (without taking samples). Continue recording data with the power supply 
 attached (a full recharge will take up to 7 hours). 

 Note: If you are using the Motion Sensor with EASYSENSE Flash Logger, the red light will not be lit  
 until a recording has started e.g. by clicking on the Start icon in Graph. 

•	 Check the power level in the EASYSENSE unit (or the Pocket PC if used with  
 Flash Logger).

Time range
The Time range will measure the time taken for the pulse to travel to the object and 
then back again. 

When used with the Time range selected, the Motion Sensor can be used to 
measure the speed of sound. Place the Motion Sensor at least one metre away 
from the object. Select either Meter or Test mode and record a value. 

Example: the Motion Sensor was placed 1 metre away from a wall (one metre to the 
wall and one metre back = a distance of 2 metres). The value for time measurement 
was 5800 µs.  

Speed =  
Distance

  =        
2

          = 344.8 ms
              Time       5800 x 10-6
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The value of the velocity of sound in air increases with temperature. 
At 0˚C, v = 331.3 ms-1. If the velocity of sound increases at 0.607 ms-10C-1 then at 
24˚C, v = 331.3 + 24 x 0.607 = 331.3 + 14.6 = 345.9 ms-1. 

Investigations
•	 Walking toward and away from the Sensor
•	 Movement of an object up or down a slope 
•	 Simple harmonic motion
•	 Newton’s laws of motion
•	 Pendulum  motions
•	 Air track gliders - collisions
•	 Acceleration due to gravity - free fall, pendulum swing, objects dropped or   
 tossed upward 
•	 Balanced forces
•	 Conservation of energy - a bouncing object
•	 Speed of sound
•	 Energy changes in simple harmonic motion
•	 Oscillation of a spring

Can be used with a Force Sensor to:
•	 Study the relationship between force & motion
•	 To study collision and impulse
•	 Simple harmonic motion
•	 Spring characteristics, extension, oscillation, SHM  

Temperature 18 C 19 C 20 C 21 C 22 C 23 C 24 C

Speed of sound in air 342.23 342.83 343.44 344.05 344.65 345.26 345.87

Temperature 25 C 26 C 27 C 28 C 29 C 30 C 31 C

Speed of sound in air 346.47 347.08 347.69 348.30 348.90 349.51 350.12
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Examples:
1. Measuring gravity by free fall - select an intersample time of 20 ms, pre-trigger  
 greater than 30 cm. Hold ball about 10 cm below the Motion sensor , click on   
 Start release the ball and move hands away quickly. 

2.  Simple harmonic motion, energy changes, extension characteristics, oscillation  
 of a spring. The Force Sensor is used to measure the force in the spring as it   
 oscillates. The position of the mass is monitored using the Motion sensor. 

Mesh guard

Force Sensor 

Spring

Motion 
Sensor

Min
17 cm
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3.  Used to plot the position of the trolley on the slope to find how the distance and
 speed change as a cart rolls up and down a slope; investigating whether 
 acceleration depends on the angle of the slope; measuring g by rolling a cart   
 down a slope; etc.

4.  Elastic and inelastic collisions using two Motion Sensors and carts on the 
 Dynamics System track.

 

 The two Motion Sensors need to be 
 angled slightly away from the track 
 (about 12˚) so their ultrasound 
 cones do not interfere. 

Motion Sensor 
attached to 
the Dynamics 
System track

Cart with 
reflector fitted
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Distance, Velocity and Acceleration 
To create a set of Velocity or Acceleration data 
1. Select either Pre-log function (not available in Scope) or Post-log function   
 from the Tools menu. 

 Use Pre-log before the distance 
 data has been recorded (the set 
 of Velocity or Acceleration data 
 will be created as logging 
 progresses).
 Use Post-log when the distance 
 data has already been recorded. 

2. Select Preset function and then 
 Motion.

3. From the drop down menu select 
 Velocity or Acceleration (second 
 derivative of distance). 

 Velocity - click on Next. Select the Distance channel, Next. Enter the units as  
 appropriate e.g. m (m/s), cm (cm/s), in (in/s), Finish.

 Acceleration (second derivative of distance) - click on Next. Select the Distance  
 channel, Next. Enter the units as appropriate e.g. m (m/s/s), cm (cm/s/s), in   
 (in/s/s), Finish.

Velocity
Distance

Acceleration
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Presets
Creating a Distance Preset
• Open Graph and select a suitable time span e.g. 10 seconds. 
• Select Sensor settings from the Display menu and alter the maximum to a   
 more suitable number e.g. 5.00 m.
• Right click in the graph area and select Predict. Use the predict tool to draw a  
 line on the graph for the pupils to follow. Click with the right mouse button to 
 finish the line. 
• Select Save Setup from the File menu. Enter a name for the experiment and   
 then a file name. 

Creating Distance and Velocity Presets
• Select 2 from Number of Graphs in the Display menu.
• Use Pre-log from the Tools menu to create a Motion / Velocity preset function  
 - alter the Y-axis limits to Manual and change to a more suitable minimum &   
 maximum value e.g. -5 to 5.  
• To display a different data set in each graph, right click in the first graph area,   
 select Show or Hide Channels and deselect Velocity. Repeat in the second   
 graph but deselect Distance. 
• Right click in the graph area and select Predict. Use the predict tool to draw a  
 line in each graph for the pupils to follow. Click with the right mouse button to   
 finish the line. 
• Select Save Setup from the File menu. Enter a name for the experiment and   
 then a file name. 

To open a preset
From the Home page select Open Setup. Select the setup you created from the list. 
Click on Start to begin recording. 

A distance preset to copy
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Warranty
All Data Harvest Sensors are warranted to be free from defects in materials and 
workmanship for a period of 12 months from the date of purchase provided they 
have been used in accordance with any instructions, under normal laboratory 
conditions. This warranty does not apply if the Sensor has been damaged by 
accident or misuse.

In the event of a fault developing within the 12-month period, the Sensor must be 
returned to Data Harvest for repair or replacement at no expense to the user other 
than postal charges.

 Note: Data Harvest products are designed for educational use and are not intended for use in industrial,
 medical or commercial applications.

   WEEE (Waste Electrical and Electronic Equipment) Legislation

   Data Harvest Group Ltd are fully compliant with WEEE legislation and are pleased to provide  
   a disposal service for any of our products when their life expires. Simply return them to us   
   clearly identified as ‘life expired’ and we will dispose of them for you.



Notes:




